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Objectives

Design data
Create tables
Understand table relationships 
Share data with Excel
Establish table relationships 

Objectives for the chapter are: design data, create tables, understand table 
relationships, share data with Excel and establish table relationships. 
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Objectives

Create a query
Specify criteria for different data types 
Copy and run a query 
Use the Query Wizard
Understand large database differences

Objectives for this chapter also include: Create a query, Specify criteria for different 
data types, Copy and run a query, 
Use the Query Wizard and Understand large database differences. 
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Table Design Considerations 

Just as you first create a blueprint to build a   
house, you should first sketch or outline the 
design of a database table

Careful pre-planning
will save you much time
in the future

Just as you first create a blueprint to build a house, you should first sketch or outline 
your table design.  (Add: Careful pre-planning saves you much time in the future. 
There are many factors that affect both the design and structure of a database.



5

Copyright © 2008 Pearson Prentice Hall. All rights reserved. 5

Table Design Considerations – Field 
Size Property

Set the field size in Table Design View
Always anticipate the current field size may 
one day need to be larger

Set field size in the Field Properties
grid of Table Design View

Set the field size property of individual fields in Table Design View. Once the field 
size is set, data entry in that field is limited to the length specified. In order to 
prepare for the future, always anticipate the current field size may one day need to 
be larger.
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Table Design Considerations –
Validation Rules 

Used to avoid data entry errors by restricting what 
can be entered 
Validation text can be used to provide an 
explanation of the type of data that is allowed in a 
field

Set validation rules in the Field Properties
grid of Table Design View

Validation rules are used to help avoid data entry errors by restricting what can be 
entered in a field.  For example, if you want a number to be entered into a field, but 
want to assure that a zero is not entered, your validation rule could be <>0.  If an 
attempt is made to enter a zero in the field, a generic error message is generated 
stating that a validation rule has been broken.  If you include validation text with a 
validation rule, the user will receive a message that you specify. Therefore, it is 
recommended to provide validation text any time you use a validation rule so that 
they user can more easily understand the error.
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Table Design Consideration –
Sarbanes Oxley Act (SOX)

Protects the general public and companies 
shareholders against fraudulent practices 
and accounting errors.

Requires that all business records be saved for a 
period of fie years and be made available to the 
SEC upon request

SOX RECORDS
Do Not

Discard

This regulation protects the general public and companies shareholders against 
fraudulent practices and accounting errors.  To summarize the act, it requires that 
all business records be saved for a period of five years and be made available to 
the SEC upon request.
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Table Design Considerations -
PNPI

Short for personal, non-public, information 
PNPI laws govern the safeguarding of data such as:

social security numbers
credit card numbers
bank account numbers
medical records

Short for personal, non-public, information, PNPI laws govern the safeguarding of 
data such as social security numbers, credit card numbers, bank account numbers 
and medical records.
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Table Design Considerations –
Store Data in its Smallest part

For greater flexibility, store data in its smallest part 
Instead of one field for an address, use many
Instead of one field for a name, two or three

Like this

Not like this

For greater flexibility, store data in its smallest part.  It is much more difficult to 
search for data when more than one piece of information is in one field.  Examples 
include: instead of one field for a persons address, break the address into three 
fields – street address, city, state and zip. Instead of one field for a persons name, 
break the name into two or three fields – first, last and possibly middle initial.
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Table Design Considerations –
Avoid Calculated Fields
Calculated fields should be used mainly in 
queries and reports

Calculated fields in a query

Calculated field in a report

Calculated fields should be used mainly in queries and reports. This is more efficient and 
allows for more accurate information.
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Table Design Consideration  -
Plan for Date Arithmetic

Using a data type of date/time for all date 
fields allows the use of date arithmetic

Fields declared 
as a data type 
of Date/Time

Using a data type of date/time for all date fields allows the use of date arithmetic. An 
example of date arithmetic usage would be subtracting the shipping date from the 
order date of an item.  The resulting number is the delay between the item being 
ordered and the item being shipped.
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Table Design Considerations –
Design Multiple Tables

Using multiple tables helps reduce redundancy
The process is also referred to as normalization

Multiple table tabs identify open tables

Multiple tables shown in the Navigation pane

Using multiple tables helps reduce redundancy. The process of reducing 
duplicate information is also referred to as normalization. 
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Creating Tables – From the 
Create Tab
Enter table data directly in fields

From the Create Tab, click Table
Use a table template

From the Create Tab, click Table 
Templates

Enter data directly into a table, 
including the field names

Enter field names, data 
types and descriptions in 
Table Design View

Begin with a template

There are many methods that can be employed to create tables.  From the Create 
tab, users can choose to enter table data directly in fields in datasheet view by 
clicking Tables form the Tables ribbon.  They can also select the Table Template 
icon from the Tables ribbon.
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Creating Tables – From the 
Import Tab

Click the application from which to import 
or 

Choose the type of file you wish to import

Click the appropriate application 
button

Choose a file type to import

When the External Data tab is used, tables can be imported into Access by clicking 
the application icon you wish to import from or the type of file you wish to import.



15

Copyright © 2008 Pearson Prentice Hall. All rights reserved. 15

Create Tables – Specifying field 
names

After choosing your method of creation begin 
implementing the table design

Use CamelCase notation for field names
Specify data types
Establish a primary key
Consider the need for a foreign key

Table View

Table 
Design View

Add field in 
Table View

After choosing your method of creation begin implementing the table 
design.  Be sure to use CamelCase notation for field names.  You will also need 
to specify the data type for each field and establish the primary key that was 
determined when planning your table.  
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Create Tables – Primary Key

Tables are automatically created with an 
AutoNumber field which serves as the primary key
To change the primary key

Select a field in Design View 
Click the primary key icon 

Primary Key Field Primary Key icon

Tables are automatically created with an AutoNumber field which serves as the 
primary key. To change the primary key, select a field in Design View and click the 
primary key icon on the tools ribbon of the Design tab.
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Create Tables – Consider a 
Foreign Key
Customer ID - Primary 
Key in Customer Table
Customer ID –will only 
appear in one record -
there must only be 
one unique id per 
customer

Customer ID - Regular 
Field in Orders Table
Customer ID may 
appear many times –
one customer can place 
many orders 

Based on the above example:
Customer Id is the foreign key in the Orders table
This is referred to as a One to Many Relationship

When planning your table always consider the possibility that you will need a foreign 
key. A foreign key in one table is the primary key in another and is created when a 
relationship between two tables is made. 
Example:
Customer ID is the Primary Key in the Customer Table
Customer ID will only appear in one record in this table.  There must only be one 
unique id per customer.
Customer ID is a Regular Field in the Orders Table
Customer ID may appear many times in this table. One customer can place many 
orders Customer ID may appear multiple times.
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Work with Table Views

Click the Home tab
Click View from the View ribbon

Table View Options

To choose a table view, click the home tab and click View from the View ribbon. 
Choose the view desired.  In Datasheet View, you will enter data directly in rows 
and columns.  PivotTable View allows you to organize and summarize groups of 
records. PivotChart View displays a chart of the associated table data.  Design View 
allows you to add or modify the structure of your table as well as individual field 
properties.
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Work with Properties

Field Properties can be used to specify 
characteristics for individual fields
Located in the lower pane of Table Design 
View

Caption property

Field Size property

Field Properties can be used to specify characteristics for individual fields. Field 
Properties can be found in the lower pane of the Table Design View.
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Working with Multiple Tables –
Table Relationships

The strength of Access is the fact that it is a 
relational database

This means you can have multiple tables and 
create relationships between each table
This helps eliminate redundant data

Relationship 
between two tables

The strength of Access is the fact that it is a relational database. This means you 
can have multiple tables and create relationships between each table. This is 
extremely important in the effort to eliminate redundant data.
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Working with Multiple Tables –
Referential Integrity

Assures that the references to relationships 
between data is accurate
Established when creating the relationship 
between two tables

Enforce Referential 
Integrity

Referential integrity helps assure that the references to relationships between data 
is accurate.  It can be established when creating the relationship between two tables 
or at a later time by editing the relationship.
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Working with Multiple tables -
Cascades

When active, data changed in one table that is in 
a relationship will be changed in its related tables
Can be set when establishing relationships 
between tables

C

Cascade update 
and cascade delete

When cascades are active, data changed in one table that is in a relationship will be 
changed in its related tables.  Cascade Update means that data changed in one table will 
be changed in other tables that it shares a relationship with.  Cascade delete means that if 
a record in is deleted in one table, the associated records in other tables it shares a 
relationship with will be deleted as well.
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Indexing

Index properties can be set in the Field 
Properties pane of table Design View
Relates the field values to the records that 
contain the field value
Helps speed up some sorting and searching 
processes

Indexed Property

Index properties can be set in the Field Properties pane of table Design View. 
Indexing relates the field values to the records that contain the field value and helps 
speed up some sorting and searching processes.
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Sharing Data with Excel

Data can be imported from Excel
It may be appended to an existing table
It may be used to create a new table

Excel icon

External Data tab

Data can be imported from Excel into Access. It may be appended to an existing 
table or used to create a new table.
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Sharing Data with Excel

Select the Excel file you would like to import
Select how you would like to import the data

Appended – added to the end of an existing table
New table – creates a new table in a database
Linked – create a new table that is linked to the source file 
in Excel

Select the Source

Select the destination

To import data from Excel, complete the following steps. Click the Excel icon in the Import 
group.  Then, in the Get External Data dialog box, select the Excel file you would like to 
import and specify how you would like to bring in the data.  You have the following options:

Appended – added to the end of an existing table, New table – creates a new table 
in a database or Linked – create a new table that is linked to the source file in Excel. 
Click Ok to finish the import.
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Establishing Relationships

Click the Database tools and click the 
Relationships icon 
In the Relationship window, click and drag a 
field name from one table to a field name in a 
related table

Relationships icon
Click and drag to create a relationship

Click the Database tools tab and click the Relationships icon in the Show/Hide 
group to open the Relationships window.
In the Relationship window, click and drag a field name from one table to a field 
name in a related table.
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Establishing Relationships

Enter the appropriate settings in the Edit 
relationships dialog box and click Create
A join line will appear when one table is 
joined to another

Infinity symbol notes referential integrity 
has been applied

Set referential integrity and cascades

After dragging a field name from one table to another, the Edit Relationships dialog 
box will appear.  Enter the appropriate settings in the Edit relationships dialog box 
and click Create.  A join line will appear when one table is joined to another. An 
infinity symbol be on the join line when referential integrity has been applied.
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Queries

Queries allow us to ask questions about data
This record set that answers our question is called a 
dataset

Employees table

Dataset resulting from querying table 
for only employees who are Sales 
Representatives

Queries allow us to ask specific questions about the data and receive a record set 
back that answers our questions. This returned record set is called a dataset.  
Simply running a query does not change the actual table data.  However, you may 
alter the data in a dataset and the changes will be reflected in the underlying table.
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Using Query Design View

Query Design grid has two panes – the table 
pane and the design pane
Striking the F6 key will toggle you between 
sections

Tables pane

Design pane

Query Design view has two panes – the table pane and the design pane. Striking 
the F6 key will toggle you between panes.
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Select Query

Searches associated tables and returns a 
dataset that matches the query parameters
Changes made to the dataset will be 
reflected in the associated tables

A select query is a basic query that searches associated tables and returns a 
dataset that matches the query parameters
Changes made to the dataset will be reflected in the associated tables.
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Specifying Criteria in a Select 
Query

Field row – displays the field name
Sort row – enables you to sort the dataset
Show row – controls whether or not you see a field 
in the dataset
Criteria row – determines the records that will be 
selected for display

Fields in design grid allow us 
to specify criteria for the 
dataset

Parts of the Design Grid include:
Field Row – displays the field name
Sort row – enables you to sort the dataset
Show Row – controls whether or not you see a field in the dataset
Criteria row – determines the records that will be selected for display
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Specifying Criteria – Currency 
and Operands

Specify criteria with currency 
Without the dollar sign 
With or without the decimal point

Use operands such as:
Less than and greater than
Equal to or not equal to

Greater than (>) operand

Currency amount entered without dollar sign

Specify criteria with currency without the dollar sign and with or without the decimal 
point. Use operands such as less than, greater than, equal to or not equal to, in 
order to compare your criteria against data in the specified field.
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Specifying Criteria – Wildcards

Asterisk - searches for a pattern that includes any 
number of characters in the position of the asterisk
Question mark - searches for a pattern that includes a 
single character in the position of the question mark

Query with asterisk wildcard 
and resulting dataset

Query with question mark and asterisk 
wildcard and resulting dataset to specify 
criteria for the dataset

The asterisk wildcard searches for a pattern that includes any number of characters 
in the position of the asterisk.
The question mark searches for a pattern that includes a single character in the 
position of the question mark.
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Specifying Criteria – Null Values

IS NULL finds only records that have no value
IS NOT NULL excludes Null value records

Is Null criteria and resulting 
dataset

IS NOT NULL criteria and partial 
resulting dataset

Specify IS NULL in the criterion field to find fields that have no data. Specify IS NOT 
NULL to exclude Null value fields from the dataset.
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Specifying Criteria – And and Or

OR finds records that can match one or more 
conditions 
AND finds records that must match all criteria 
specified

Or Criterion and resulting 
dataset

And criterion and resulting 
dataset

Use the OR criterion to find records that can match one or more conditions 
specified. Use the AND criterion to find records that must match all criteria 
specified.
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Copy a Query

Right click on the query - chose Copy form the 
shortcut menu
Right click and chose paste
In the Paste as dialog box, give the query a 
new name

One way to copy is query is to right click on the query in the Navigation pane and 
chose Copy from the shortcut menu. Right click again in the navigation pane and 
chose paste. In the Paste as dialog box, give the query a new name.
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Run a Query

Running, or executing, a query is done by 
clicking the Run command 

Run command

Running, or executing, a query is done by clicking the Run command located by 
clicking the Design tab and accessing the Results group.
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Creating Queries – Using the 
Query Wizard

From the Create tab, choose Query Wizard for the 
Other group
Choose query type from the New Query dialog box

Query Wizard icon

Select Simple Query Wizard

To create a query using the Query Wizard, click the Create tab, choose Query 
Wizard from the Other group and choose the query type from the New Query dialog 
box.
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Creating Queries – Using the 
Query Wizard: continued

Select the Table/Queries to include and choose the 
desired fields
Select aggregate totals needed in the Summary 
Options box

After establishing the type of query you wish to create, select the Table/Queries you 
wish to base your query on and choose the desired fields. Select aggregate totals 
you wish to display in the Summary Options box.
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Creating Queries – Using the 
Query Wizard: continued

Title your query and open in Datasheet View or Query 
Design View

The final step in using the Query Wizard is to name your query and open in Datasheet View 
or Query Design View.
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Understand Large Database 
Differences

Most large companies separate their 
database into front and back ends

Front end – contains the objects needed to 
interact with data, but not the tables where the 
record values reside
Back end – contains the tables where the data 
resides

To ensure data integrity, to maintain security and to avoid mishaps, most large 
companies separate their database into front and back ends.
Front end – contains the objects needed to interact with data, but not the tables 
where the record values reside.
Back end – contains the tables where the data resides
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Be sure to read the material in the text carefully, complete the exercises as directed 
by your instructor, and ask questions as they arise.


